
IX.G. Saving and Printing the Analysis File

1. The Plexor™ Analysis Software saves the analysis as an *.aan file. The
current analysis can be saved at any time by selecting “Save Analysis File
(.aan)” in the “File” menu.

2. Selected wells can be exported into a new analysis file. In the “File” menu,
select “Export Selected Wells as New Analysis File (*.aan)”.

3. The analysis screen can be printed or saved as a screenshot. In the “File”
menu, select “Save a Screenshot (.png)” or “Print a Screenshot”.

4. A Run Template and Analysis Template from an existing analysis can be
exported and used in future analyses (Section XI.C).

X. Troubleshooting

Symptoms Causes and Comments
Flat amplification curve in the Be sure that the reactions were assembled correctly. See the 
amplification curves window Technical Manual supplied with the Plexor™ Systems.
(no apparent amplification) Template was degraded or of insufficient quantity. Verify the 

integrity of the DNA or RNA template by electrophoresis. 
Repeat the DNA or RNA purification if necessary. Add 
RNasin® Ribonuclease Inhibitor to the reaction to inhibit a 
broad spectrum of RNases.
Amplification inhibitor is present in the DNA or RNA template.
Reduce the volume of template in the reaction. Repeat the 
DNA or RNA purification if necessary. Add the template in 
question to the positive control reaction. A significant increase 
in the Ct value or no amplification in the positive control 
reaction indicates the presence of inhibitors in the template.
Thermal cycler was programmed incorrectly. Verify cycle times
and temperatures (Section IV, V or VI).
Data collection settings were incorrect. Data collection must 
occur during the extension step. The extension time must be 
sufficient for data collection. Verify the data collection settings.
The wrong dye or detector was selected, or the dye was 
incompatible with the instrument. Be sure the selected 
detectors are appropriate for the fluorescent dyes used.
The Plexor™ Master Mix may have lost activity. Be sure to 
store the Plexor™ qPCR and qRT-PCR Systems at –20°C to 
avoid loss of enzyme activity. Confirm the instrument settings 
and perform a positive control reaction to determine if there 
is a problem with the Plexor™ System reagents.
The primer sequence is incorrect. Verify the primer sequence.
Poor primer design. Redesign primers, targeting a different 
region of the gene of interest. We strongly recommend using 
the Plexor™ Primer Design Software, which is available at: 
www.promega.com/plexorresources/
Primers may have been synthesized incorrectly. Resynthesize 
primers.
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X. Troubleshooting (continued)

Symptoms Causes and Comments
Flat amplification curve in the Primer was degraded. Use MOPS/EDTA Buffer to resuspend 
amplification curves window and dilute primers. Iso-dC-containing primers are sensitive to 
(no apparent amplification) pH. Rehydrating or storing the primer in water or a buffer 
(continued) with a pH less than 7.0 will result in primer degradation. Do 

not use water to resuspend or dilute primers or make primer 
mixes.
Primer concentration was incorrect. Verify the primer 
concentration by measuring the absorbance at 260nm.
The scale of the Y axis was inappropriate. If the scale of the 
Y axis was too broad, the change in fluorescence may not be 
visible. Adjust the scale of the Y axis.

Increasing fluorescence over time Excessive template was added to the reactions. Dilute the 
template and re-amplify.
The baseline region was set in a region with significant 
fluorescence fluctuation. The baseline within the baseline 
region should be flat. Manually adjust the baseline region 
(Section XI.D).
The baseline region was set too close to the signal change. 
Manually adjust the baseline region Section XI.D.

Two or more distinct melt curves in For the Plexor™ qRT-PCR Systems, both RNA and DNA 
the melt curves window templates can be amplified. Treat the RNA template with 

DNase to eliminate contaminating genomic DNA.
Poor primer specificity. Design new primers with higher 
specificity to the target. To verify primer specificity, perform a
BLAST search with the primer sequence. The primer should 
not exhibit regions of identity with other sequences.
Optimize the annealing temperature. Increase the annealing 
temperature by increments of 2°C to reduce the synthesis of 
primer-dimers or nonspecific amplification products.
Pseudogenes or polymorphic genes may exist. Design new 
primers to avoid regions of identity between gene family 
members.
Assemble the reactions on ice to minimize the synthesis of 
primer-dimers or nonspecific amplification product.
Reduce the number of amplification cycles to minimize the 
synthesis of primer-dimers or nonspecific amplification 
product.
Check for signal bleedthrough. Calibrate the instrument as 
instructed by the manufacturer for the dye set used.
Decrease the primer concentration (e.g., 0.1µM).
Primer pairs in a multiplex reaction can interact to form 
undesired amplification products. Perform a BLAST search to 
reveal regions of identity with undesirable target sequences. 
Label the primer with the lowest homology to other sequences.
Alternatively, design new primers using the Plexor™ Primer 
Design Software, which is available at: 
www.promega.com/plexorresources/
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X. Troubleshooting (continued)

Symptoms Causes and Comments
Broad melt curve or a shoulder on Pseudogenes and polymorphic genes may exist. Perform a 
the melt curve BLAST search of the target sequence. When designing 

primers, choose target sequences that have the fewest regions 
of identity with pseudogenes and polymorphic genes.
Check for signal bleedthrough. Calibrate the instrument as 
instructed by the manufacturer for the dye set used.
Decrease the primer concentration (e.g., 0.1µM).
Be sure the thermal cycler is programmed correctly 
(Section IV, V or VI).

No melt curve observed in the Poor amplification. See causes and comments for “Flat
melt curve window amplification curve in the amplification curves window 

(no apparent amplification)” above.
Problems with data export or instrument analysis have 
occurred. Review the instructions for data export and 
instrument setup.
Data collection settings were incorrect. Verify the thermal 
cycling program and data collection settings are correct 
(Section IV, V or VI).
Incorrect files were imported. Be sure to import the proper 
files containing related amplification data and dissociation data.
Instrument was programmed incorrectly. Verify the thermal 
cycling program is correct (Section IV, V or VI).

Variability in signal among Calibrate your pipettes to minimize variability in pipetting.
replicate samples Small volumes are difficult to pipet accurately. Do not pipet 

volumes <1µl; dilute the template, so larger volumes are 
pipetted.
Some variation is normal. A difference of 1–2 cycles for the Ct

values is within the normal variation associated with an 
exponential amplification reaction.
There will be statistical variation in the amount of template in 
a reaction with targets present at low copy number. Poisson 
distribution predicts difficulty associated with reliable detection
of very dilute samples with few target molecules.
Mixing was inadequate. Vortex reagents to mix well prior to 
pipetting.
Use capillaries recommended by the instrument 
manufacturer.
Instrument was improperly calibrated. Calibrate instrument
as instructed by the manufacturer.
Thermal cycling conditions were suboptimal. Optimize the 
annealing temperature.
Thermal cycling conditions were suboptimal. Redesign your 
primers, so the melting temperatures are 60°C. We strongly 
encourage using the Plexor™ Primer Design Software.
Viscous samples (e.g., high-molecular-weight genomic DNA) 
are difficult to pipet accurately. Dilute the DNA template. 
Shear high-molecular-weight DNA by vortexing or pipetting.
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X. Troubleshooting (continued)

Symptoms Causes and Comments
Variability in signal among The baseline region was not set correctly. The baseline should 
replicate samples (continued) be flat. The baseline region can be adjusted manually for each 

well to account for sample-to-sample variation (Section X.ID).
Be sure the capillaries are properly sealed to avoid 
evaporation.

Fluorescence decrease observed in Nonspecific product can accumulate at higher cycle number in 
the no-template control reactions with targets present at low copy numbers. Assemble

the reactions on ice to reduce the accumulation of nonspecific 
amplification products.
Decrease the cycle number to reduce the accumulation of 
nonspecific amplification products.
Design new primers using the Plexor™ Primer Design 
Software.
Reactions were contaminated with target DNA or RNA. Clean 
workstations and pipettes with a mild bleach solution before 
and after use. Use new reagents and solutions. Take 
precautions to prevent contamination (see the Plexor™ qPCR 
System Technical Manual #TM262, the Plexor™ One-Step 
qRT-PCR System Technical Manual #TM263 or the Plexor™ 
Two-Step qRT-PCR System Technical Manual #TM264).
An improperly calibrated instrument can lead to erratic 
fluorescence readings. Calibrate the instrument as instructed 
by the manufacturer.

Vertical fluorescence spikes or Consult the instrument manufacturer’s user’s manual for
significant “noise” in the information about potential instrument problems that can
amplification curve cause spikes or noise.

No amplification or poor amplification for the entire run.
Poor amplification can lead to improper data scaling, making 
the fluorescence measurements appear erratic. See possible 
causes and comments for “Flat amplification curve in the 
amplification curves window (no apparent amplification)” 
above.
Instrument was improperly calibrated. Calibrate instrument
as instructed by the manufacturer.

Small signal change in No amplification or poor amplification. See causes and 
amplification curve and melt comments for “Flat amplification curve in the amplification 
curves curves window (no apparent amplification)” above.

Incorrect filter was selected. Verify the presence of the 
appropriate filter.
Primer concentration was incorrect. Verify primer 
concentration by measuring the absorbance at 260nm.
The scale of the Y axis of the amplification curve was affected 
by other reactions on the plate. A high fluorescent signal for 
one or more reactions can cause the scale of the Y axis of the 
amplification curve to be too high to see changes in some data.
Adjust the scale of the Y axis to accommodate samples with 
smaller changes in fluorescence. See Section IX.D.
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X. Troubleshooting (continued)

Symptoms Causes and Comments
Nonlinear standard curve, An amplification inhibitor is present in the standard reference 
low R2 values template. Determine whether the template contains inhibitors 

by adding the DNA template to the positive control reaction; 
a significant increase in the Ct value or no amplification of the 
positive control in the presence of the DNA template indicates
the presence of inhibitors. Repeat purification of the standard 
reference template used to generate the standard curve.
Calibrate your pipettes to minimize variability in pipetting.
Small volumes are difficult to pipet accurately. Do not pipet 
volumes <1µl; dilute the template, so larger volumes are 
pipetted.
Viscous samples (e.g., high-molecular-weight genomic DNA) 
are difficult to pipet accurately. Dilute the DNA template. 
Shear high-molecular-weight DNA by vortexing or pipetting.
Adjust the baseline region. The baseline region can be 
manually adjusted for each reaction. See Section XI.D.
Some variation is normal. Perform duplicate or triplicate 
reactions for the standard curve to minimize the effect of this 
variation.
There will be statistical variation in the amount of template in 
a reaction with targets present at low copy number. Perform 
duplicate or triplicate reactions for the standard curve.
An error was made during dilution of the standard reference 
template. Verify all calculations, and repeat dilution of the 
standard reference template. Do not pipet volumes <1µl.
Incorrect concentration values were entered in the Plexor™ 
Analysis Software. Verify the concentrations for all samples 
used to generate the standard curve.
Reactions were contaminated with target DNA or RNA. Clean 
workstations and pipettes with a mild bleach solution before 
and after use. Use new reagents and solutions. Take 
precautions to prevent contamination (see the Plexor™ qPCR 
System Technical Manual #TM262, the Plexor™ One-Step 
qRT-PCR System Technical Manual #TM263 or the Plexor™ 
Two-Step qRT-PCR System Technical Manual #TM264).
Carefully seal the capillaries to avoid evaporation.
Aberrant fluorescence can be caused by writing on capillaries, 
contamination, fingerprints, etc. Do not write on the capillary. Use
caution when handling capillaries. Wear gloves. Do not place 
capillaries on surfaces that might be contaminated with a 
fluorescent material. If you suspect contamination of the 
benchtop, thermal cycler block or any other area, clean it 
thoroughly.
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X. Troubleshooting (continued)

Symptoms Causes and Comments
Slope less than 0.2 No amplification or poor amplification. See causes and 
(inefficient amplification) comments for “Flat amplification curve in the amplification 

curves window (no apparent amplification)” above.
Nonspecific amplification can become a problem in later 
amplification cycles with samples containing small amounts of 
target template. Decrease the number of amplification cycles.
Poor primer design. Design new primers.
Annealing temperature was too high. Design new primers 
with melting temperatures of 60°C. We strongly recommend 
using the Plexor™ Primer Design Software.
Annealing temperature was too high. Optimize the annealing 
temperature.

Amplification in no-reverse Contaminating DNA sequences related to the RNA template
transcription control for the are present in the RNA preparation. Treat the RNA template
Plexor™ qRT-PCR Systems with DNase to remove contaminating DNA.

Design new primers to span introns to avoid amplification of 
contaminating genomic DNA.
Nonspecific amplification occurring in reactions that contain a 
low number of copies of the template. Assemble reactions on 
ice.
Decrease the number of amplification cycles to reduce 
accumulation of nonspecific amplification products.
Design new primers to minimize the synthesis of nonspecific 
amplification products.
Reactions were contaminated with target DNA or RNA. Clean 
pipettes and workstations with a mild bleach solution before 
and after use. Use new reagents and solutions. Use positive-
displacement pipettes or aerosol-resistant tips to reduce cross-
contamination during pipetting. Use a separate work area and 
pipettes for pre- and postamplification. Wear gloves and 
change them often.

No amplification in the positive No amplification or poor amplification. See causes and 
control reaction comments for “Flat amplification curve in the amplification 

curves window (no apparent amplification)” above.
Verify that the thermal cycling program and data collection 
settings were correct (Section IV, V or VI).
Instrument setup problems can cause amplifications to fail. 
Consult the instrument manufacturer’s user’s manual for more
information about potential instrument problems.
The Plexor™ Master Mix may have lost activity. Be sure to 
store the Plexor™ qPCR and qRT-PCR Systems at –20°C to 
avoid loss of enzyme activity. Confirm the instrument settings, 
and perform a positive control reaction to determine if there is
a problem with the Plexor™ System reagents.
The RNA template used in the Plexor™ qRT-PCR System was 
contaminated with ribonuclease (RNase). Take precautions to 
prevent RNase contamination. Clean workstations and pipettes
with a mild bleach solution before and after use. Use new 
reagents and solutions.
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X. Troubleshooting (continued)

Symptoms Causes and Comments
No amplification in the positive The RNA template used in the Plexor™ qRT-PCR Systems was 
control reaction (continued) degraded. RNA storage conditions are very important. Store 

RNA template at –70°C in single-use aliquots to minimize the
number of freeze-thaw cycles. Once thawed, keep RNA on ice.
Always use nuclease-free, commercially autoclaved reaction 
tubes, sterile aerosol-resistant tips and gloves to minimize 
RNase contamination.
Reactions were assembled incorrectly. Repeat the experiment 
and assemble reactions as described in the Plexor™ qPCR 
System Technical Manual #TM262, the Plexor™ One-Step 
qRT-PCR System Technical Manual #TM263 or the Plexor™ 
Two-Step qRT-PCR System Technical Manual #TM264.

Unable to import data. An error The data has been altered after export from the real-time PCR
like “Expecting NEWLINE, instrument software. Any alteration of this data is likely to 
found’’” or “Unexpected Token change the formatting and can cause import errors. Do not 
Error” is encountered open the exported files with other software programs.
Data display in the Plexor™ Analysis Be sure that the display settings for the computer are set to
Software appears abnormal 32-bit color, rather than 16-bit color, when using the Plexor™
(the screen appears compressed, Analysis Software.
lines are replaced with dots, etc.)
Genotyping: Miscalled known Poor primer design. Redesign primers. We strongly recommend
heterozygous samples: Product using the Plexor™ Primer Design Software, which is available 
formed with only one of the two at: www.promega.com/plexorresources/
genotyping primers The annealing temperature was too high or too low. Optimize 

the annealing temperature.
Genotyping: Miscalled known Poor primer design. Redesign your primers. We strongly 
homozygous samples: Product recommend using the Plexor™ Primer Design Software, which
formed (signal decrease) with is available at: www.promega.com/plexorresources/
both primers The annealing temperature is too high or too low. Optimize 

the annealing temperature.
Genotyping: Miscalled known The primer sequence was incorrect. Verify that the primer 
homozygous samples: Product sequence is correct.
formed only with the mismatched 
primer but not with the matching Genotyping primer #1 and primer #2 were switched. Verify
primer that the correct primer was used.
Genotyping: No call Add more template. 

Redesign primers. 
See comments for “Flat Amplification Curve.”
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XI. Appendix

XI.A. Plexor™ Analysis Software Operating System Compatibility

The Plexor™ Analysis Software is compatible with the following operating systems:
Windows® 98, Windows NT® 4, Windows® ME, Windows® XP and Windows® 2000.
Other operating systems are not supported. The Plexor™ Analysis Software is not
compatible with Macintosh® computers.

Be sure that the display settings for the computer are set to 32-bit color, rather than
16-bit color, when using the Plexor™ Analysis Software.

XI.B. Plexor™ Analysis Software Installation

The Plexor™ Analysis Software and installation instructions are available for
download at: www.promega.com/plexorresources/. The software is also available
free-of-charge on CD-ROM by request. Consult the Promega Web site to verify that
you are installing the most recent version of the software. Following installation, the
program can be accessed in the “Start” menu: Programs\Plexor\Analysis Desktop.

Instructions for Installing the Plexor™ Analysis Software from CD-ROM

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the “Plexor.exe” installer icon on the CD-ROM and follow
the on-screen instructions to install the software.
Note: Installation of the software may take several minutes. There is a
pause where the computer may appear to be inactive between the launch
of the installer and the software installation.

XI.C. Advanced Options

At the “File Import” screen, Step 3 (Figure 18), there are two “Advanced Options”
buttons: “Run Template” and “Analysis Template”. These options allow plate
configuration and assay parameter information to be saved for reuse during routine
experiments.

Run Template: A run template is used to assign sample types, sample colors and
concentrations of standards (Figure 33). If you routinely use the same setup for
plates of standard samples and unknowns, a run template can be created, stored
and applied to subsequent runs.

1. Select “Run Template”.

2. Assign colors, sample types and concentrations to the standards in the
“Plate Setup” tab.

3. Use the “Sample IDs” tab to label your samples. Simply select the sample
you wish to name and start typing.

4. Select “Export” to save the plate configuration to a *.rtp file for later use.

5. Select “OK”.

To import an existing *.rtp file that contains a saved plate configuration, select
“Import” and browse to that file.
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XI.C. Advanced Options (continued)

Analysis Template and Definition of Analysis Functions: The analysis template is
used to optimize the analysis settings for the experiment. If you routinely perform
reactions with the same analysis conditions, an analysis template can be created,
stored and applied to subsequent runs. These settings can be exported as a *.ntp file,
then imported for subsequent experiments. A description of the functions for each
setting follows.

1. Select “Analysis Template”.

2. Enter the desired values for the analysis defaults for each dye used 
(Figure 34).
Note: Descriptions of the analysis details are provided below.

3. Select “Export” to save the default settings to a *.ntp file for later use.

4. Select “OK”.

To import an existing *.ntp file that contains the saved default settings, select
“Import” and browse to that file.

Default Amplification Threshold (RFU) Baseline Noise Standard Deviations: The
Plexor™ Analysis Software has a user-definable amplification threshold that
determines the RFU value at which sample cycle thresholds are called.

This value is based on the variation (noise) in the baseline regions of all samples and
is determined by taking the mean and standard deviation of all RFUs in baseline
regions. The threshold is set a specified number of standard deviations below the
mean. The default threshold is 10 standard deviations but can be changed in the
Analysis Template or recalculated at any time by using “Set Amp Threshold from
Selected Samples” option in the “Edit” menu (see Section IX.D).
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Figure 33. A Run Template.
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Default Melt Threshold –d(RFU)/dT Percentage: The melt curve allows you to
distinguish amplification products with different sequences and lengths. In the
absence of nonspecific amplification products, the melt curve will have one peak.
Each sample has a melt curve, from which a Tm can be determined. A Tm value is
reported for all melt curves that cross the melt threshold. The melt threshold
represents the –d(RFU)/dT value that is required before a Tm value is reported for 
a sample. A sample’s Tm value is calculated as the temperature at which the melt
curve has the lowest (i.e., the most negative) –d(RFU)/dT value.

The default melt threshold –d(RFU)/dT percentage is preset at 25.0% and can be set
between 0.0 and 100.0%. This value is used by the software to calculate the melt
threshold value. The Tm threshold value is defined as a percent of the –d(RFU)/dT
value for the sample with the lowest –d(RFU)/dT value in the data set.

The melt threshold value is recalculated when a standard curve is generated. The
melt threshold value can be manually adjusted by clicking and dragging the
horizontal melt threshold line.

Expected Target Melt Temperature: The expected target melt temperature is the melt
temperature of the correct PCR product. The expected target melt temperature must
be between 65°C and 95°C. The default expected target melt temperature is 90°C.

Target Tm Upper Bound: The target Tm upper bound is the number of degrees
Celsius above the expected target melt temperature at which a sample Tm is
considered to be suspect. The default target Tm upper bound is +1°C.

Target Tm Lower Bound: The target Tm lower bound is the number of degrees
Celsius below the expected target melt temperature at which a sample Tm is
considered to be suspect. The default target Tm lower bound is –1°C.

50
61

TA

Figure 34. The Analysis Defaults tab.
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XI.D. Manual Baseline Adjustments

The proper baseline region is important for optimal analysis of Plexor™ System
data. Baseline regions are automatically determined during import of data into the
Plexor™ Analysis Software.

The baseline region is set in a flat region of the amplification curve before the
beginning of the downward inflection that indicates product accumulation. In some
instances, manual adjustment may provide optimal representation of the data. This
may include samples with excessive noise, bleedthrough or early Ct values or
situations where the real-time instrument shows early signal fluctuation.

1. Select the “PCR Curves” tab.

2. Select the “Display and Manually Adjust Baselines” icon:

3. Select the samples to be adjusted using the Well Selector.
Note: The baseline region can be adjusted for individual samples or
groups of samples by selecting or dragging the lower and upper limits.
The shading in the baseline region will be gray if the selected samples do
not share a common baseline region (Figure 35). For multiplex assays, the
baseline is set independently for each dye.

4. Adjust the upper limit of the baseline region for each sample, so the upper
limit is approximately 5 cycles before the decrease in fluorescence and in
an area where the baseline is flat. The Ct values for selected samples are
displayed in the table to the right of the graph. The Ct value may change
when the limits are changed. See Notes 1 and 2.

5. If necessary, adjust the lower limit to a region that creates the flattest
baseline given the selected upper limit.

6. Optional: The amplification threshold is based on noise within the
baseline region for all of the samples. When manual baseline adjustments
are complete, consider recalculating the amplification threshold for all
samples. Select all samples, and in the “Edit” menu, select “Set Amp
Threshold from Selected Samples” (Section IX.D). See Notes 3 and 4.
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Figure 35. An amplification window showing the baseline region and baseline upper and lower
limits.
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Notes:
1. A maximum upper limit of 35 cycles can be used for samples without a Ct

value (e.g., no-template control).

2. Samples with similar Ct values can be adjusted simultaneously by
highlighting multiple wells.

3. The baselines for all samples can be reset to the automatic setting by
selecting the “Reset Baselines and Amp Thresholds” icon:

4. To reset the baselines for a selected set of samples, select the samples in
the Well Selector, and in the “Edit” menu, select “Set Baselines for Selected
Samples”.

XI.E. Icon Definitions

Assign Color (shortcut = “q”)

The “Assign Color” function allows you to select a color in which a sample is
displayed. This color selection is associated with those samples in the amplification
and melt curves, Well Selector and any reports. Select one or more capillaries using
the Well Selector, then select this button to choose the desired color for the selected
samples. These colors are not transferred to printed copies or exported reports.
Sample color does not change the analysis of a sample in any way.

Assign Unknown (shortcut = “w”)

The “Assign Unknown” function allows you to assign the sample type “unknown”
to all selected samples. Select one or more capillaries using the Well Selector, then
select this button to assign the sample type “unknown”. Unknown samples are
displayed as open squares in the Well Selector. They are labeled “unknown” in
reports. When included in a standard curve, the concentrations of unknown samples
will be calculated and reported.

Assign NTC (shortcut = “e”)

The “Assign NTC” function allows you to assign the sample type “no-template
control" to all selected samples. Select one or more capillaries using the Well
Selector, then select this button to assign the sample type “no-template control”. No-
template control reactions are displayed as diamonds in the Well Selector. They are
labeled as “no-template control” in reports. When included in a standard curve, the
concentrations of sample in the no-template control will be calculated and reported.

Assign Positive Control (shortcut = “t”)

The “Assign Positive Control” function allows you to assign the sample type
“positive control” to all selected samples. Select one or more capillaries using the
Well Selector, then select this button to assign the sample type “positive control”.
Positive control samples are displayed as hexagons in the Well Selector. They are
labeled “positive control” in reports. When included in a standard curve, the
concentrations of positive control samples will be calculated and reported.
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XI.E. Icon Definitions (continued)

Assign Standard (shortcut = “r”)

The “Assign Standard” function allows you to assign the sample type “standard” to
all selected samples. Select one or more capillaries using the Well Selector, then
select this button to assign the sample type “standard”. Only samples that have
been assigned a type of “standard” will be used to generate the best-fit line in
standard curves. All standard samples must be assigned a concentration by the user
when they are defined as a standard. Concentrations may be entered in standard
format (0.01, 0.1, 1, 10, 100, 1000, etc.) or scientific format (1e-2, 1e-1, 1e0, 1e1, 1e2,
1e3, etc.). The software does not accept commas in the concentration assignments.
Standard samples are displayed as circles in the Well Selector and standard curve
graphs. They are labeled “standard” in reports.

Create Dilution Series (shortcut = “f”)

The “Create Dilution Series” function creates a full dilution series within a row or
column of capillaries. Select the capillaries that contain a dilution series of the
standard, then select “Create Dilution Series”. You must enter the initial
concentration of the series, the dilution factor and whether the series is increasing or
decreasing (Figure 14). Concentrations may be entered in standard format (0.01, 0.1,
1, 10, 100, 1000, etc.) or scientific format (1e-2, 1e-1, 1e0, 1e1, 1e2, 1e3, etc.). The
software does not accept commas in the concentration assignments.

All selected capillaries will be assigned the sample type “standard” with the
appropriate concentration. This function can only be performed with standards
within the same row or column. Using this function produces the same result as
selecting each capillary in the series individually and assigning it the sample type
“standard” with the appropriate concentration. Only samples that have been
assigned the sample type “standard” will be used to generate the best-fit line in
standard curves. Standard samples are displayed as circles. A row or column of
capillaries within a dilution series of standards may be assigned as standards
simultaneously by highlighting multiple capillaries and using the “Create
Dilution Series” function.

Add Standard Curve (shortcut = “d”)

The “Add Standard Curve” function fits the experimentally measured Ct values and
user-entered concentration values for standard samples to a straight line using the
least mean squares method. It will calculate the concentrations of unknown samples,
positive control reactions and no-template control reactions from their measured Ct

values using the equation for the best-fit line. Any sample with a concentration of
“N/A” on the report or elsewhere did not cross the cycle threshold, so the
concentration of that sample cannot be calculated.

Select all of the samples you wish to use as standard samples, as well as all other
samples for which you wish to calculate concentrations. Choose “Add Standard
Curve” from the “Edit” menu. Type “d” or select the “Add Standard Curve” icon on
the toolbar.
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You may create as many standard curves as you wish for a single set of data, but no
sample can be used to generate more than one standard curve. It is not possible to
add samples to an existing standard curve, but a new curve can easily be
constructed with a new selection. This action will remove the existing standard
curve and generate the new standard curve using the samples you have selected.
You may generate the original standard curve at any time.

Remove Standard Curve (shortcut = “c”)

The “Remove Standard Curve” function removes the standard curve on the tab that
is currently selected. This function is only available in the “Standard Curves” tab.

Display and Manually Adjust Baselines

The “Display and Manually Adjust Baselines” function allows you to set the
baseline range for a sample or set of samples. Select one or more wells using the
Well Selector, then select this button. See Section IX.D.

Reset Baselines and Amp Thresholds

The “Reset Baselines and Amp Thresholds” function allows you to reset the baseline
range and amplification threshold for all samples. See Section XI.C.

XI.F. Amplification Efficiency Calculations

The Plexor™ Analysis Software automatically calculates the equation for the best fit
line and determines the R2 value of the standard curve. The R2 value is a measure of
the fit of the data points to a straight line. An R2 value of 1.0 is a perfect fit. R2 values
should be close to 1.0.

The software also calculates the slope of the standard curve. The slope is an indication
of the efficiency of the PCR. At 100% efficiency, the amount of amplification product
doubles with every cycle, so Ct values differ by 1 for each twofold dilution of the
template. At 100% efficiency, the amount of product increases tenfold every 3.32 cycles
(23.32 = 10), so Ct values differ by 3.32 for each tenfold dilution. A reaction with 100%
efficiency will have a slope of –3.32 when the amplification curve is displayed with
the Ct values on the Y axis and log concentration on the X axis. When the
amplification curve is displayed as Ct versus log concentration, the efficiency may
be calculated as [(10–1/slope) –1] × 100% (1).

XI.G. Reference

1. Bustin, S.A. (2004) A–Z of quantitative PCR. International University Line, La Jolla
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(a)This product is designed and sold for use in the multiplex PCR process covered by U.S. Pat.
No. 5,582,989 and Canadian Pat. No. 1,339,731. A limited license has been granted under the
patent to use only this amount of the product to practice the multiplex PCR process and is
conveyed to the purchaser by the purchase of this product. 

(b)Patents for the foundational PCR process, European Pat. Nos. 201,184 and 200,362, expired on
March 28, 2006. In the U.S., the patents covering the foundational PCR process expired on
March 29, 2005. 

(c)The purchase of this product conveys to the buyer the limited, nonexclusive, nontransferable
right (without the right to resell, repackage, or further sublicense) under U.S. Published Patent
Appln. 20020150900 and U.S. Pat. Nos. 5,432,272, 6,617,106 and 6,140,496 to use the product.
No other license is granted to the buyer whether expressly, by implication, by estoppel or
otherwise. In particular, the purchase of this product does not include or carry any right or
license to sell this product. For information on purchasing a license for other uses, please
contact Promega Corporation, Licensing, 2800 Woods Hollow Road, Madison, WI 53711, or
EraGen Biosciences, Corporate Licensing, 918 Deming Way, Suite 201, Madison, WI 53717.
Phone (608) 662-9000; Fax (608) 662-9003. 

© 2005–2007 Promega Corporation. All Rights Reserved.

RNasin is a registered trademark of Promega Corporation. ImProm II and Plexor are
trademarks of Promega Corporation.

CAL Fluor is a registered trademark of Bioresearch Technologies, Inc. LightCycler is a
registered trademark of Roche Diagnostics, GmbH. Macintosh is a registered trademark of
Apple Computer, Inc. Microsoft, Windows and Windows NT are registered trademarks of
Microsoft Corporation. Texas Red is a registered trademark of Moleculare Probes, Inc.

Products may be covered by pending or issued patents or may have certain limitations. Please
visit our Web site for more information.

All prices and specifications are subject to change without prior notice.

Product claims are subject to change. Please contact Promega Technical Services or access the
Promega online catalog for the most up-to-date information on Promega products.
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